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NOTHING QUITE grabs the attention 
like a black & white image. It can be 
classic, timeless, and direct. I love it. 
In this booklet – the sixth in our 
hugely popular practical series about 
using your D-SLR – we examine many 
of the aspects you’ll need to master 
in order to become a successful black 
& white photographer. That includes 
both the skills in recognising the 

potential in a scene, as well as the 
imaging techniques required to 
develop that potential. Where the 
fi lm photographer once relied on the 
almost mystical know-how of the 
darkroom, these days the D-SLR 
owner puts his faith in software like 
Photoshop to bring his images to life. 
It’s important to point out that not 
every colour image you take with 
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your D-SLR will successfully convert 
into a powerful and engaging black & 
white. I’d suggest that if you choose 
to explore the joys of mono then you 
go out in search of them specifi cally, 
rather than shoot in the hope that 
one or two might, by chance, have 
the right ingredients. My shot of a 
canal (above) is a case in point. It 
was a drab, dull scene in colour but in 
tones of black & white it’s a far more 
graphic and moody photo.  
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The rain-splattered 
railings and canal 
towpath were not 
instantly engaging. 
But converted to 
black & white, then 
dodged & burnt to 
bring out the tones, 
it comes to life.



?? | Shooting black & white on your D-SLR

Seeing in black & white

 | 5

Seeing in
black & white
Training the brain to view the world in shades of grey is 
easier said than done. But let’s start by looking at how to 
interpret colour scenes and what can be achieved in mono...    

Seeing in
SHOOTING BLACK & WHITE ON YOUR D-SLR
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T he key to taking great black & white pictures is 
being able to visualise how the colours in the 
scene will convert to the different tones in the 

fi nal image. As you’ll fi nd out further on in this 
booklet, you can infl uence this by the way that you 
process or convert your digital fi les, but there are still 
some simple principles that will help you produce the 
most successful black & white photographs. Mono 

images work because of the tonality and contrast that 
they contain. Unfortunately, as we see in colour, not 
black & white, it is often the colour saturation or colour 
contrasts that actually attracts us to particular subjects. 
While these qualities can sometimes be translated to 
create a good black & white image, you will need to 
be able to recognise when this will work well and 
when it simply won’t. 

Tonality – what to look for

‹Subjects and qualities 
that don’t convert well 
Images that rely on the contrast 
between two or more colours often 
don’t work well in black & white. 
Although they look very different in 
colour, they can become a similar 
tone when converted to black & 
white and merge into each other. 

SATURATED COLOURS
This image works in colour because of the  
strong red of the poppy. Colour contrasts 
that have similar tonal values don’t always 
convert well to mono.

COLOURED BACKGROUND
The blurred poppies in the background 
echo the red of the main fl ower, and also 
add interest to the green colours of the 
grasses in the background.

CONTRASTING COLOURS
The green of the background creates a 
strong contrast with the reds of the fl owers. 
This helps the main fl ower to stand out, 
and gives bags of eye-catching impact.       

✘ FLAT TONES
The dappled greens and 

reds of the background are fl at 
and too uniform once converted 
to black & white.

✘ LOSES IMPACT
The poppy has lost all its 

impact in black & white, as the 
red has become a mid-grey. 

✘ NO CONTRAST
Overall the image has become 

too fl at to be successful. There’s too 
little contrast and the main subject 
has merged into the background.
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‹Subjects and qualities that do convert well
Images that convert successfully into black & white often contain simple graphic 
shapes or complex textures, both of which create interest and impact in the 
monotone image. Look for subjects that contain a range of tones, rather than 
just colour, to give plenty of contrast in your fi nal image.

Tonality – what to look for

FOCAL POINT
Placing the dark tree 
against the lighter 
grasses and sky works 
well in colour, but the 
tree does merge with 
the neutral tones of the 
far distance. 

TEXTURE
The warm tones of the 
grass in the foreground 
tend to overpower the 
image. The strong 
colour also means that 
some of the fi ne detail 
and texture in the grass 
is lost.

SKY DETAIL
The sky has a range of 
tones that will convert 
well to black & white, 
and also retain plenty 
of detail to add interest 
to the sky.

✔ TONAL RANGE
As it contains a range 

of different tones, the detail 
in the sky is retained when 
the image is converted. 

✔ 
STRONG CONTRAST
This dark tree creates a 

simple, graphic composition that 
works perfectly in black & white.

✔ 
ENHANCED DETAIL
The texture and shapes 

created by the grass in the 
foreground become even more 
apparent when the image is 
converted to black & white. 
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W ithout the impact or emotion of colour to grab 
your attention, black & white images need to 
contain more graphic qualities to work 

successfully. The main elements to look out for are 
shape and form, or texture that can be used to help 

the impact and composition of your black & white 
shots. As well as the subject itself, strong directional 
lighting, found most readily early and late in the day, 
can help to enhance both shape and texture to create 
incredibly graphic images. 

Use light and composition 
to create graphic images

€Shape and form
Strong, graphic shapes help to add 
impact to your mono images – look 
out for both man-made and natural 
subjects that have simple, graphic 
shapes, or subtle curves. Simplicity is 
often the key to using shape and 
form in your black & white images, 
so try to ensure that the subject fi lls 
the frame for maximum impact, or 
try to crop out any distracting 
elements to make the shape or 
pattern stand out. This is also a great 
way of creating abstract images, 
where shape and form becomes the 
most important subject, rather than 
the object that you are shooting. 

‹Sidelighting
Strong, directional lighting helps 
to create shadows and highlights 
that bring out both shape and 
texture of the scene. For outdoor 
images try to shoot when the sun 
is low in the sky, rather than 
overhead, and choose your 
position so that the light is 
coming from one side of the 
subject rather than from behind 
or in front of the camera. If you 
are using a controllable light 
source, such as a fl ashgun or 
lamp, position it away from the 
camera. On-camera fl ash, for 
instance, creates very fl at results 
and so is very poor at revealing 
the shape or texture of a subject.  

Texture
As well as shape and form, black & white is also 
excellent for highlighting a subject’s texture. Tight 
framing, so that the texture of the subject fi lls the 
whole frame, can create an abstract image. 
Alternatively, you can use the texture of a subject as 
part of the overall composition, when other objects 
are included in the scene. 
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The abstract 
nature of black & 
white also 

makes it excellent for 
creating moody and 
atmospheric images. 
The simplicity of 
colourless images, 
and the fact that they 
are so far removed 
from the way we see 
the world around us, 
means they are often 
better at conveying 
these moods than 
colour images. In 
general, images containing lots of darker tones 
often appear moodier than more tonally balanced 
images, while lighter tones give shots a fresher, 
happier mood. So look for subjects that lend 
themselves to either of these treatments, and then 
slightly underexpose your shot for a darker image, 
or slightly overexpose for a lighter image. 

BLACK & WHITE TIP
The stronger the ND grad fi lter you 
use, the darker the sky will be. So 
use a 1-stop or 0.3 ND grad if you 
only want to add subtle detail, use 
a 2-stop or 0.6 ND grad if you want 
to step up the drama and use a 
3-stop or 0.9 ND grad for maximum 
impact. The choice is yours!  

€‹Mood
The range of tones in the image 
largely determines the overall 
mood of your black & white shots. 
An image full of dark tones 
portrays a much heavier, more 
dramatic mood than one 
containing mainly lighter tones. 
This range of tones can be 
achieved when you are shooting 
your mono images by 
overexposing by a 1/2 to 1 stop for 
lighter images, and underexposing 
by a similar amount for darker 
ones. As with traditional black & 
white photography, you can also 
adjust your images to suit the 
effect that you are after. Using the 
Curves and Levels adjustments 
available in Photoshop you can 
make your image lighter or darker 
to suit the mood of your image – 
turn to page 28 for more info.

€Atmosphere
Naturally atmospheric conditions 
such as dramatic skies and mist are 
perfect subjects for black & white. 
The pure tones of mono allow you 
to concentrate all your attention on 
making the most of these 
conditions. You can maximise the 
effect by using an ND grad fi lter to 
darken the sky when you take the 
shot, but don’t forget that you can 
also use the dodging and burning 
techniques found on page 30. 

Urban portraits full 
of darker tones, not 
to mention concrete 
and graffi ti, are 
perfect black & 
white fodder.     

A 0.9 ND grad fi lter 
was used to increase 
the drama in this 
stunning view of 
Rannoch Moor.

Galloping zebras (a ready-
made black & white subject if 

ever there was one) kicking up 
dirt makes bags of atmosphere. 

Capture mood 
and atmosphere
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Shooting in 
black & white
Changing a few in-camera settings and using optical fi lters 
such as grads and polarisers can greatly help you improve 
your mono masterpieces before they even reach your PC. 

Shooting in 
SHOOTING BLACK & WHITE ON YOUR D-SLR
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Shooting in black & white

One of the greatest advantages of shooting 
digital over fi lm is that you can shoot both 
colour and black & white images without the 

hassle of changing cameras or fi lms. You can even 
shoot everything in colour and decide which to convert 

to black & white later on and, if you shoot in RAW 
format, you can use exactly the same camera settings 
for both. To get the best black & white results from 
JPEGs, however, you may need to change a couple of 
settings from those that you would normally use. 

Camera settings

BLACK & WHITE TIP

The main setting to consider is the in-camera sharpening. For 
colour images that you will use straight from the camera this is 
often set to the normal or high settings, but both of these can 
cause problems with lines and halos around some details when 
you come to convert these colour images to black & white. So 

for high quality black & white shots you may want to turn the 
in-camera sharpening off and then use your software to sharpen 
the images after you’ve completed your conversion and any 
image enhancement. Find out how to do this on the popular 
Canon EOS 400D and Nikon D80 D-SLRs below...

1 Open the second screen of the Camera Settings 
menu            by pressing the Menu button and 
using the four-way navigation buttons. Then scroll 

down to the Picture Style option and press the Set button 
to open the available settings. 

2From the list of settings scroll down to the Neutral 
option using the up and down buttons. Make sure 
that the number for the sharpening setting on the 

left of the list is 0, then press the Set button to confi rm 
these settings. 

fiCanon EOS 400D

1Press the Menu button and use the up and down 
buttons on the D-pad to choose the green camera 
icon on the left to open the Shooting Menu. Then 

use the right button of the D-pad to open the Optimize 
image option.

2Use the up and down buttons of the D-pad to choose 
the Custom setting, then press the right button to 
open the available settings. Select Image 

sharpening and choose None by using the up and down 
buttons on the D-pad, then press OK.

fiNikon D80 ›IN-CAMERA SHARPENING
With the in-camera sharpening set to normal you can 
fi nd that you get lines around details, particularly on 
areas adjoining blue sky. On this example you can see 
an obvious line above the hills where the sharpening 
has been applied.

›NO IN-CAMERA SHARPENING
Turning the in-camera sharpening off allows you to get 
a better black & white conversion from your colour 
images. Remember to apply some sharpening once 
you’ve fi nished adjusting your image and before you 
print it out, though.

Tone compensation
To cope with high contrast subjects you 
can also adjust the contrast or tonal 
range settings on your digital SLR. This 
is set through the same Optimize 
image or Picture Style menus as the 
sharpening. For high contrast subjects 
you need to use a setting that allows 
the camera to capture a wider range 
of tones in the image, so use a lower 
contrast setting. 

NORMAL

LOWER CONTRAST

Sharpening
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Shooting in black & white

W hen shooting black & 
white fi lm you use 
coloured fi lters to change 

the way that colours are recorded 
as tones in the fi nal image. As this 
tonal adjustment can now be done 
when you convert your digital 
image from colour to black & 
white, using fi lters on your D-SLR is 
more about ensuring that your 
image contains a full range of 
tones than altering how these 
tones will be recorded. One of the 
classic uses of fi lters in black & 
white photography is to increase 
the contrast between blue sky and 
white cloud. A key technique for 
successful digital black & white is 
making sure the sky contains a full 
range of tones so that there is 

plenty of scope 
to adjust these 
when you 
convert your 
image. It’s 
almost 
impossible to 
keep detail in 
the sky while at 
the same time 
correctly exposing the foreground 
without using any fi lters on the 
camera. When converted into black 
& white you’ll simply end up with 
a fl at, bland sky. So rather than use 
the traditional red, yellow and 
green fi lters, there are two types of 
fi lters that are particularly useful 
for shooting digital black & white – 
ND grads and polarisers. 

Optical fi lters

BLACK & WHITE TIP

€ND grad
Whether you’re shooting in 
colour or black & white, an ND 
grad fi lter allows you to darken 
the sky while leaving the 
foreground unaffected. This will 
help you to get more contrast in 
the sky and create a punchier 
image when you reach the 
conversion stage. ND grads 
come in a range of strengths, 
most commonly giving a 1, 2 or 
3-stop (also known as 0.3, 0.6 
and 0.9 ND respectively) 
difference between the clearest 
and darkest part of the fi lter. For 
shots of blue skies you’ll fi nd a 
1 or 2-stop fi lter suffi cient to 
retain detail, while shooting 
towards the sun you’ll need at 
least a 3-stop grad to retain 
detail in the brightest areas of 
the sky. For this shot, we used a 
0.6 ND grad to darken the sky by 
2 stops. 

›Polariser
Polarisers stop certain types of light reaching the sensor and are used to 
darken blue skies and increase contrast between sky and clouds. You need to 
rotate the fi lter for maximum effect, which you can see through your 
viewfi nder. Slowly rotate the fi lter and stop when the sky is at its darkest.

For even greater impact you can also combine the effect of a polariser and 
ND grad fi lters. This can produce dramatic dark skies and help to add to the 
mood of your black & white landscape shots. 

›NO FILTERS
While the scene has bags of black & 
white potential, the original photo, 
taken with no polariser or ND grads, 
suffers from a lack of impact. The most 
obvious problem is the lack of tonal 
variation in the sky, meaning there’s 
a reduced contrast throughout.

POLARISER

0.6 ND GRAD

0.6 ND GRAD WITH POLARISER

NO FILTERS
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Conversion & 
enhancement
Take full advantage 
of Photoshop and 
Elements to create 
stunning black & 
white images, from 
RAW conversion and 
fi lters to Curves, 
Levels, dodging and 
burning. Let’s take a 
more detailed look...

Conversion & 
SHOOTING BLACK & WHITE ON YOUR D-SLR
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Shooting RAWs rather than 
JPEGs is undoubtedly the best 
way to get quality black & 

white images. However, you need 
to ensure that you are processing 
your RAW fi les correctly to get the 
most from them, and are taking 
advantage of the extra quality that 
RAW fi les offer.

Converting RAWs for mono

‹What RAW settings 
should I use?
Most RAW converters offer few 
options for creating black & white 
images apart from dragging the 
saturation slider down to 0 so all the 
colour is sucked out of your image. 
In most situations this won’t give us 
the best results, particularly if you 
have Photoshop or Elements 5. What 
you actually need to do is process a 
standard colour image in the RAW 
converter then convert it to black & 
white in your imaging software 
afterwards. We’ll talk more about 
Photoshop and Elements later, but 
here we’re going to look at what 
RAW settings you should be worried 
about when working with a mono 
image in mind. We’re using the 
Elements 5 RAW converter in this 
example, but similar settings can be 
found in other leading RAW 
converters too.

8-BIT AND 16-BIT
Selecting 16-bit will give you smoother tones across 
your image, which is important if you’re likely to make 
severe contrast adjustments in Photoshop. The reason 
for this is that your original RAW is likely to be 12-bit or 
14-bit, and as such can differentiate between at least 
4096 different shades of grey. Standard images are 8-bit 
and can only describe 256 shades of grey. This loss of 
data can become obvious when you start dodging and 
burning and using Levels or Curves. With 16-bit, 
however, you may fi nd that many Photoshop features 
are disabled, including the use of Layers in Elements.

BLACK & WHITE TIP
The colour images with the most 
potential are those with plenty of 
contrast in both brightness and 
colour. The trees in the image above 
are partially silhouetted, which will 
transfer well to black & white. Also, 
the green grass contrasts with the 
blue sky – this difference can be 
enhanced in the Channel Mixer.

WHITE BALANCE
It’s generally best to select 
the correct white balance 
preset, or use the 
eyedropper, to give your 
image accurate and neutral 
colours. This will help 
separate the colours and 
make life easier in 
Photoshop.

SHADOWS AND 
HIGHLIGHTS 
CLIPPING
With these options ticked 
you’ll be able to see if you’re 
overdoing your adjustments 
and are likely to lose picture 
information, such as shadow 
detail. If there’s a problem, 
the area in question will turn 
a contrasting warning colour, 
at which point you’ll know 
to ease back on the 
adjustments you are making. 
However, you should use 
your own judgement too.

SMOOTHING/
NOISE REDUCTION
Avoid using any noise 
reduction unless you really 
have to. Colour noise 
reduction may look fi ne 
with colour images but 
can be a big problem with 
black & white, giving your 
images a soft appearance.

SHARPNESS
Sharpening will 
improve the clarity of 
fi ne detail but it can 
cause problems when 
you go mono – 
sharpening halos can 
become much more 
visible around strong 
edges. Use sharpening 
sparingly if you must, 
or disable it altogether.

SATURATION
Surprisingly, colour saturation 
can massively affect how the 
image will look when 
converted to black & white, 
particularly if you’re using the 
Channel Mixer. Use this slider 
to create a well-saturated, but 
still natural-looking, image.

SHADOWS, 
CONTRAST AND 
BRIGHTNESS 
You can use these sliders 
to add punch to your 
image and change the 
brightness of the midtones. 
However, this can always 
be done in Photoshop 
afterwards and you’ll have 
more control there, so use 
these sliders sparingly.
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LAB CONVERSION
This technique doesn’t offer any control 
over the look of the fi nal black & white 
conversion, but it does produce incredibly 
smooth and detailed mono images. To try 
this technique yourself, fi rst go to Image> 
Mode>Lab Color. Now bring up the Channels 
palette (Window>Channels) and click on 
the Lightness channel – this will turn your 
image black & white, which is the exact 
result we want, but we’re not done yet. To 
fi nish, discard the other two Channels by 
going straight to Image>Mode>Grayscale 
and click OK when prompted.

There isn’t a standard way to remove the colours from your image to 
give a classic punchy mono image – there are loads of different ways 
and all of them create subtly different effects. Here we’re going to look 

at our two favourite techniques using the full version of Photoshop and, 
frankly, they are probably the only two techniques you’ll ever need…

Go black & white 
in Photoshop 

‹The Channel Mixer
The Channel Mixer offers the most 
fl exible and interactive way to 
remove the colours from your shots, 
as it allows you to precisely adjust 
the tone and contrast of the fi nal 
black & white image. The reason it’s 
so special is because it works by 
converting the separate red, green 
and blue (RGB) channels into 
grayscale images. Each channel 
displays lighter pixels where there is 
plenty of that channel’s colour 
present, and darker pixels where 
there is very little of that colour. For 
example, a bright red postbox 
contains lots of red so will appear 
almost white in the red channel, but 
the same postbox will look almost 
black to the other channels as it 
doesn’t contain any green or blue. 
This principle is similar to that of 
using different coloured contrast 
control fi lters with black & white 
fi lm to make the sky darker or 
foliage brighter. The Channel Mixer 
allows us to mix and blend the 

different channels together to create 
a huge range of different mono 
effects very quickly. 

Using the Channel Mixer
It may sound very complicated, but 
it’s actually really easy to use. First, 
bring up the Channel Mixer by going 
to Image>Adjustments>Channel 
Mixer. Now tick the Monochrome 
box to turn your image black & 
white. You have three main sliders 
that represent the brightness of the 
three colour channels. All you’ve got 
to do now is mix them up to adjust 
the look of the different coloured 
areas and produce a powerful mono 
image. Before we do this, start by 
looking at each channel in isolation 
to get a feel for what you’re doing. 
To do this simply enter +100% for 
each channel in turn, ensuring that 
the other two channels are set to 
0%. Also, remember that the more 
of a single channel you add in, the 
brighter the relevant colours will be.

RED CHANNEL GREEN CHANNEL BLUE CHANNEL

Above: The fi nal image  
was created by mixing 
the three channels 
together (see inset). 
Adding lots of green 
has made the grass 
nice and bright, and 
subtracting blue has 
darkened the sky.

MIXED CHANNELS
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GO BLACK & WHITE IN THE RAW CONVERTER 
If you don’t have Elements 5 then you 
may also want to try making black & 
white images directly in Elements’ 
RAW converter. Here we’re going to 
reveal a few simple tricks that will 
allow you to adjust the black and 
white tones in your image to give 
some control over the look of the fi nal 
result. Remember, this only works with 
compatible RAW images, not JPEGs. 

First of all, drag the Saturation slider 
down to 0 to remove all colour. Then 
experiment with the Exposure, Contrast 
and Brightness sliders to give your 
image some punch. Now, the secret of 
this technique actually relies on the 
White Balance settings – by adjusting 
the white balance sliders we can 
change the look of the image. Try 
moving the Temperature and Tint 
sliders to fi nd an effect you like.

Elements users are a bit limited when it comes to the number of ways 
you can convert your colour images to black & white. Having said 
that, great results can still be had, particularly if you have the latest 

version, Elements 5. Here are our favourite ways to turn your shots into 
black & white masterpieces in Photoshop Elements.

Go black & white 
in Elements

This fi lter is new to Elements 5 so 
you won’t fi nd it in the previous 
versions, but it is a really powerful 
feature and is easily our favourite 
way to convert your images to black 
& white in Elements. It works in a 

very similar way to Photoshop’s 
Channel Mixer but is much more 
visual and offers some handy 
presets too. To run this fi lter, go to 
Image Enhance>Convert to Black and 
White or use the Alt+Ctrl+B shortcut.

USING CONVERT TO BLACK AND WHITE FILTER

‹Convert to Black and White fi lter

›Grayscale
If your image is already very 
contrasty, or doesn’t contain much 
colour, then you may fi nd that 
smoother results can be had if you 
make a straight Grayscale 
conversion. This technique also 
allows you to work on a full 16-bit 
image rather than having to convert 
to 8-bits/Channel fi rst (depending 
on your version of Elements). This 
will lead to smoother results later on 
if you’re going to make severe 
contrast adjustments such as 
dodging, burning and Levels. 
Converting to black & white with 
Grayscale is really quick and easy. All 
you have to do is go to 
Image>Mode>Grayscale and click 
OK when asked if you want to 
discard the colour information.

BEFORE/AFTER
Here you can see a thumbnail version of 
your start and fi nish images so you can 
quickly identify the different colour areas 
in your original and directly compare it 
with the fi nal result. 

STYLE
Here you’ll fi nd a range of presets that 
create different looks to get you started. 
If you’re not happy with any of these 
then you can easily modify them using 
the adjustment buttons.

ADJUSTMENT BUTTONS
This is where the magic happens. Simply click the More Red, More Green and More Blue 
thumbnails to lighten the relevant colour areas in your image. Clicking More Blue here 
will lighten the blue sky. Conversely, the Less buttons will darken the relevant colour 
areas. The two thumbnails on the far right control the overall contrast, and you’ll 
probably need to use these in conjunction with a low Adjustment Intensity.

ADJUSTMENT INTENSITY
This slider changes the severity of the 
adjustments. If you drag it to the right, 
you’ll notice that the difference between 
the thumbnails (to the right) becomes 
more pronounced. Moving the slider to 
the left will allow for fi ner adjustments.

RESET
Should you make a mess of 
your image simply click here 
to reset all of the values to 
their default positions so you 
can start from scratch.

CONVERT TO BLACK 
AND WHITE EXPLAINED...
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Above: A basic 
‘s’ curve can be 
made to boost 
the contrast of 
any image.

Right: You may need to customise the 
curve to suit your image. Here we’ve 
really boosted the highlights to 
bleach out the background.

Levels was used to set the 
black and white points for 
better clarity. Then Curves 
was applied to brighten the 
highlights and midtones to 
add style and impact. 

Contrast is probably the single most important 
consideration when working on your pictures in 
your image editor. Not enough contrast and your 

pictures will look fl at and uninspiring. Too much contrast 

and you’ll lose valuable image detail as different tones 
start to blend into one another. What you need is 
precise control over the contrast, and there are just two 
tools you need for this job – Levels and Curves.

Add contrast with 
Levels and Curves

‹Levels
The Levels command can be found in 
both Elements and Photoshop, and even 
some RAW converters. Its main purpose 
is to ensure that there is a full range of 
tones in the image, ranging from pure 
black through to pure white. Most black 
& white images only include very dark 
greys and light greys at their extremes. 
To use Levels fi rst hit Ctrl+L to bring up the dialogue box. Look for gaps on both 
sides between the edge of the histogram’s ‘mountain range’ and the 
surrounding box. If there are any, simply move the sliders found at the bottom 
corners of the histogram box so they line up with the graph edges as shown. 
You can also adjust the brightness of the midtones using the middle slider if you 
wish – drag it to the left to brighten the midtones or to the right to darken them.

‹Curves
Curves can only be found in the full 
version of Photoshop and some 
RAW converters. Elements 5 does 
offer the Color Curves command, 
which can be used to achieve a 
similar effect, but it does handle 
very differently. Curves gives more 
control than Levels as it allows you 
to independently adjust the 
brightness of the different tones in 
your image. It needn’t replace 
Levels altogether though. You’ll 
probably fi nd the best results can be 
had using Levels fi rst then Curves for 
a really strong effect. Here we’re 
just going to look at a key Curves 
technique – boosting the midtone 
contrast with an ‘s’ curve. To achieve 
this, fi rst bring up Curves by going to 
Image>Adjustment>Curves by 
hitting Ctrl+M. To create a standard 

‘s’ curve, fi rst click on the bottom 
quarter of the diagonal line to create 
a box ‘handle’. Now drag this box 
down to create a simple downward 
facing curve – this will darken the 
entire image. Next, click on the top 
quarter of the line and drag it up an 
equal amount. This step will lighten 
the highlights but the shadows will 
stay dark because the fi rst ‘handle’ 
is pinning the curve in place. You 
can now tweak the settings to 
create a look that you like. Use the 
lower left-hand box to adjust the 
dark tones, and move the upper 
box to adjust the highlights. Adding 
more ‘handles’ will allow you to 
create more complex curves but 
you’ll seldom need more than 
three or four points to achieve the 
best results. 

AFTER LEVELS & CURVES

BEFORE ADJUSTMENT

AFTER LEVELS
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Global contrast adjustments, made across the 
whole of your image, won’t always be the 
answer to getting the best-looking mono 

masterpiece. To give an image real punch, and to 
enhance the textures and draw the viewer’s 
attention to your focal points, you’ll need to make 
contrast adjustments to smaller areas of the image 
too. This idea is even more crucial when working 
on photos that contain both very bright and dark 
areas, as in our image here. Global contrast 
adjustments will just exacerbate the difference. 
Let’s take a closer look at this example image, and 
identify what needs to be done to improve the 
overall aesthetic of the shot.

Dodging and burning
First we need to split the proposed corrections into 
two distinct groups – large area adjustments and 
small area adjustments. It’s best to start with the big 
adjustments fi rst, to create a good foundation for the 
fi ner adjustments later, so let’s look at these fi rst. In 
the large area category, we have just two corrections 
– darkening the entire sky and adding contrast to the 

bottom half of the image. For these two corrections 
we’ll be using a separate technique that gives a 
smoother fi nish. What we’re going to do is make a 
rough selection over the offending area and then 
smooth out our selection so no joins are visible. Then 
we’re going to use Levels or Curves on the selection 
to brighten it, darken it or add more contrast. 

STEP 1: USING SELECTIONS

1 Lasso 
the area: 
First 

select the Lasso 
tool and drag a 
loose selection 
around the area 
you wish to 
adjust. It’s 
important that your selection goes right up to the edges 
of the image where relevant – dragging a selection that 
actually runs outside the edges of the image can do 
this. When you release the mouse button, the oversized 
selection will shrink to fi t the image perfectly. 

2Feather 
and 
correct: 

Next you need 
to soften the 
edges of the 
selection. To do 
this go to 
Select>Feather 
and enter between 150 and 200 pixels for the Radius, 
then click OK. You’re now ready to bring up Levels or 
Curves to correct the selected area. Here we darkened 
the sky using the midtone slider in Levels and applied 
an ‘s’ curve to the bottom of the image. 

START IMAGE

FINISHED IMAGE

 ➥Turn to see what a difference dodging and burning can make to your images...

STEP 1 RESULT

Add contrast and 
drama to your images... CLOUDS

The dark and light 
areas of the clouds 
could be exaggerated 
to make it more 
stormy and dramatic.

FOREGROUND 
The bottom half of 
the image is lacking 
contrast and could 
do with a lift.

HUT
The front of this hut is 
a bit dull and needs to 
be brightened. Adding 
a little contrast here 
will also make it a 
stronger focal point.

DETAIL
There are lots of small 
details on the ground, 
which could be 
brought out to add 
more texture and 
interest to the image.

SKY
The whole sky is too 
bright and needs to 
be darkened to 
bring out the cloud 
detail and balance 
the image.

Let’s take a closer look at this example image, and 
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Dodging and burning
STEP 2: DODGE & BURN TOOLS

With the image roughly balanced out using large selections, it’s time to 
turn your attention to the fi ner details. To tackle the remaining corrections 
we’re going to use the Dodge and Burn tools. These tools allow us to 
darken the shadow areas and lighten the highlights respectively, to add 
extra contrast to our image. These tools offer precise control so are better 
suited for work on smaller details. Here’s how to use them...

FINISHED IMAGE

Dodging is the process of 
lightening an area of a 
photo. Traditionally, this 

would be done by physically shading 
an area of the print during exposure, 
but in Photoshop we have the 
handy Dodge tool, which is much 
more controllable. It’s usually found 
grouped together with the Burn and 
Sponge tools in the toolbox, so click 
and hold on either of these tools to 
bring it up if you can’t see it. Here 
we’re going to set up the tool for 
brightening the highlights in our 
image, as this is the most useful 
arrangement. However, it can also 
be used to brighten midtones and 
shadows too if needed. In the 

Options bar at the top of the screen, 
select Highlights from the Range 
menu and drop the Exposure down 
to around 5%. Now, choose a large 
soft-edged brush from the Brush 
menu – around 300px for the 
Diameter is about right. Now all you 
need to do is paint over the areas 
of the image you want to lighten – 
remember that it’ll affect the 
highlights more than the shadows 
and midtones, so concentrate on 
these lighter objects. The effect will 
take a while to build up, but this is 
ideal as it’s far more controllable to 
use. Here we dodged the front face 
of the hut, the light areas of cloud 
and the rocks on the grass.

‹The Burn tool
This tool does the exact 
opposite of the Dodge 
tool and darkens areas 

of your image. It can be used to 
darken the shadows, midtones or 
highlights independently, but 
normally it’s best when used for 
darkening select shadow areas 
– this will make them even more 
intense and crisp. To prepare this 
tool for action, fi rst select it from 
the toolbox, then choose 
Shadows for the Range and 5% 
for Exposure. A large 300px 
soft-edged brush is also 
recommended, as it’ll give a less 

patchy fi nish and pixel-perfect 
accuracy is not required. You’re now 
ready to paint over the shadows on 
your image that you want to 
intensify. You’ll have to keep going 
over the areas to build up the 
desired effect over time, but just 
keep the brush moving and you’ll 
get there in the end. We burned in 
the grass, the dark areas of cloud 
and the top-right of the sky to fi nish 
off the original corrections we 
identifi ed. However, we also did 
some work on the trees, the roof 
and the hut’s shadow too, just to 
give the image a bit more clout.

›The Dodge tool
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Printing &   
presentation

Which paper should I use? How 
can I best present my work? How 
do I create neutral black & white 
prints? Turn the page to fi nd all 
your questions answered...   

Printing &   
SHOOTING BLACK & WHITE ON YOUR D-SLR
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Printing & presentation

It’s all very well being able to shoot stunning black & 
white photos, but if you’re not going to show them 
off in their best light then you’re missing a trick. 

With home printing being so affordable, and with so 
many new and exciting presentation ideas at our 
disposal (just look at the plethora of classifi ed ads in 

the back pages of Practical Photography), it’s never 
been easier to create professional looking prints for 
maximum impact. Now that you’ve shot your image, 
converted your RAW fi le and crafted the perfect mono 
image, just a few clicks in Photoshop will give your 
pictures that fi nishing touch. Here’s how...

Presentation

Add a stroke
A stroke, or hairline border, is simply 
a thin line that wraps around your 
image and is designed to contain 
and defi ne. A stroke can be added to 
any image but is particularly 
effective when there are either very 
light tones or very dark tones 
towards the edges of the frame, 
which would otherwise be lost. 
Once you’ve added a stroke, you can 
also add a thin border, creating an 
image that wouldn’t look amiss in a 
fi ne art gallery. 1 Open your image in Photoshop or 

Elements, click Ctrl+A to select all and 
go to Edit>Stroke. Enter a pixel value 

in the Width box – the higher the number 
the thicker the stroke – and select a stroke 
colour from the Color Picker palette. In the 
Location box click Inside and leave the 
Blending option on their defaults settings. 

2 To add a border, go to Image>Canvas 
Size (or Image>Resize>Canvas Size in 
Elements) and tick the Relative box. 

Use the Canvas extension drop-down menu 
at the bottom of the dialogue box to select 
a suitable colour – white and black are 
obvious choices – and in the Width and 
Height boxes enter your border size. 

‹Canvas prints 
When something hits the 
Ikea showrooms you know 
it’s going to popular! 
Canvas prints are a 
relatively cheap and easy 
way to show off your 
work – prices start at 
around £45 for a 
40x40cm canvas – and 
can even be made to 
measure if you’ve a 
penchant for 
panoramics. Pictures 
are printed onto 
canvas (look out for 
companies that use 
woven artists’ canvas 
as this is a more durable material) and 
stretched over a wooden frame, ready to hang.  

€Picture frames 
Subtlety is the key to successfully framing and 
hanging black & white prints. There’s little 
point in spending hours fi nely crafting a 
tonally perfect mono print only to slap a 
neon pink frame around it. Consider your 
décor (black, white or neutral coloured 
frames and mounts are preferable when 
dealing with mono pictures), display at 
eye-level for maximum impact if at all 
possible, avoid hanging pictures 
opposite large windows and above 
radiators to avoid damage, and hang 
in humid conditions to keep dry. Find 
info on paper choice over the page. 

‹Photo books 
To create an album all you have to do is upload 
your pictures, choose an album and throw in a few 
captions, and wait for the postman to deliver your 
album. And they’re not as expensive as you might 
think – Jessops Picture House (visit www.jessops.
com) offers hardcover, paperback and pocket-sized 
MemoryBooks, with prices starting at just £7.99. 
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Epson boffi ns predict that by 2009 over 53 billion 
images will be taken and stored each year in 
Western Europe alone. If even 1% of these 

images are printed, that’s a hell of a lot of prints! The 
increasingly popular DIY route necessitates three key 

ingredients – a printer, ink and, of course, paper. So 
how do you go about choosing from the massive array 
of photo paper available? Well, there are four key 
factors to consider – fi nish, weight, size and life span. 
We’re going to concentrate on the fi rst and arguably 

Paper choice

›Portraits
If your portrait pictures are going to be handled – 
wedding photos, for example – a semi-gloss photo 
paper (also known as satin or pearl) is the ideal 
choice as it’s less likely to show fi ngerprints! Try 
Jessops Photo Satin and Epson Premium Semi-
gloss. For punchy portraits with bags of contrast, a 
glossy photo fi nish is the obvious choice. Giving a 
smooth and super shiny appearance that could 
easily be mistaken for traditional 
photo lab prints, glossy photo 
papers look expensive and give 
maximum impact. Consider 
Jessops Photo Gloss and Epson 
Premium Glossy. 

›Landscapes
If your landscapes are laden with pastel sunsets and 
gentle contours, the smooth and velvety fi nish of a matt 
photo paper such as Jessops Photo Matt Heavyweight 
will lend your scenics a professional touch. At its best 
matt photo paper can give your photos an artistic look 
and feel. At its worse it can look a little dull, resembling 
just another sheet of white card or thick paper. Perhaps 
its greatest asset is that it’s 
perfect for framing, as its non-
refl ective surface means that 
spotlights won’t cause unsightly 
glares. For a more modern feel, 
with slightly more contrast, use 
a semi-gloss fi nish.

›Graphic
Graphic images are all about contrasts and 
extremes – plenty of blacks, plenty of whites and 
not a lot in between. Subjects such as architectural 
studies, minimalist landscapes and even high-key 
portraits require a photo paper that can cope with 
such demands. Glossy is the answer. Glossy photo 
paper such as Jessops Photo Gloss and Epson 
Premium Glossy gives extra contrast, with deeper 
blacks, crisp shadow detail and 
whiter whites. Also consider 
Ilford Galerie Smooth Fine Art 
Paper for a classier touch.

›Fine art
Subjects such as delicate still life and artistic nudes 
often require paper above and beyond the other three 
options here. If you’re prepared to pay a few quid extra, 
there’s a whole world of textured papers that offer a 
more artistic fi nish. Ilford, Permajet and Harman each 
offer a comprehensive range of fi ne art papers, from 
lightly textured matt surfaces to parchment, linen and 
watercolour surfaces. Try a fi bre-based paper such as 
Harman Inkjet Heavyweight Matt for starters. Tip: 
Some fi ne art papers are 
only coated on one side, 
which tends to be stickier. 
To fi nd out which is the 
coated side, lick your fi ngers 
and see which side sticks! 

THINKING OF SELLING YOUR WORK?
If your photography is more than a hobby and you’d 
like to sell your work, the Giclée fi ne art print is the 
way forward. A Giclée is a digital print made with 
exceptionally high-resolution printers and special 
pigment-based inks that can be used on virtually any 
artists’ materials. It’s not something you can do at 
home without expensive equipment and you won’t 
fi nd it on the high street either. Take a look in PP’s 
classifi ed advertising section for specialist printers. 

the most important factor, fi nish. To unleash your 
photo’s true potential, you need to choose a paper 
fi nish that best complements its content, whether a 
portrait, landscape or fi ne art study. Here are a few 
suggestions to get you started…
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Inkjet printers have made it simple to produce prints 
from digital black & white images. We’ve covered 
the basics of which papers to use, but it can still 

take a little time and effort to get the best quality 
results from your choice of paper. The main hurdle is 
to avoid colour casts and get neutral prints. If you’re 
really lucky you might get neutral results without 
having to change any of the settings, but it’s likely 
that you’ll need to fi ne-tune the settings for each 
type of paper you use, especially if you want to use 
different papers for different effects.

How to get 
neutral black 
& white prints

‹What’s a test print?
A test print is a way of saving both 
time and precious ink and paper. By 
using a suitable image along with a 
simple grayscale, you can get the 
settings right for the test print, then 
use the same settings when you 
make your actual prints. This is a 
simple way of calibrating your 
printer, inks and paper but you will 
need to make a new test print when 
you change either paper or ink.

‹Which image to use?
When it comes to choosing images 
to use as test prints you can use 
shots of almost any subject, but 
make sure that they are pure black 
& white – don’t use ones that you 
have toned or added any colour to. 
They also work best if the image has 
a full range of tones, from solid 
black to solid white, with plenty of 
midtones to help you assess any 
colour casts in different shades in 
the print. 

As well as the image itself, it’s 
also handy to include a grayscale to 
make it even easier to spot any 
potential problems. This is a 
graduated block that includes a 
range of tones from black to white. 
Remember to leave some space to 
write notes, such as the date, paper 
type and inks used to make it easier 
to refer back to when you change 
any of the settings. 

Half the battle to getting neutral 
prints is recognising when there is a 
colour cast on your images. Then you 
need to adjust your printer settings 
to compensate for it. When it comes 
to assessing your prints, it’s best to 

let your test prints dry fully (ideally 
for 24 hours), then view them under 
normal daylight rather than artifi cial 
lights to make sure that you can 
accurately spot any colour casts. 
As printers are based on the principle 

of combining cyan, magenta and 
yellow coloured inks, it can be 
diffi cult to know which settings you 
need to adjust to compensate for 
colour casts on your prints. This table 
should help you…

MAKE A TEST PRINT

BLACK & WHITE TIP
Most inkjet printers offer an option 
to only use the black ink. This can 
make it easier to get neutral 
results, but our advice is to stick 
with using the colour inks as you’ll 
get smoother, higher resolution 
results from most models. The 
exception to this is the dedicated 
black & white mode offered by 
some high-end inkjet printers. 

COLOUR CASTS

COMPENSATION 
NEEDED

COLOUR CAST TABLE

CYAN

INCREASE
CYAN

REDUCE
MAGENTA

INCREASE
MAGENTA

REDUCE
YELLOW

INCREASE
YELLOW

COLOUR CAST 
ON THE PRINT

REDUCE
CYAN

RED MAGENTA GREEN YELLOW BLUE

Leave some space to write 
notes on the print, such as the 
date, paper type and inks used. 

‹Producing 
your test print
Once you’ve decided on your test 
image, print it out using your normal 
settings, allow it to dry fully and then 
view it under normal daylight to 
check for any colour casts. Using the 
reference chart (right) adjust the 
settings in your printer driver to 
correct the colours, then repeat the 
procedure until you are happy with 
the result. Keep a note of these 
settings with the paper you have 
used just in case. You can also save 
the settings in the printer driver, with 
the paper type as the fi le name. This 
means you can use these settings 
again simply and easily by selecting 
this fi le when you produce another 
print on this paper.  ➥Turn to fi nd out about contact sheets and your printer’s colour controls... 

PCs and printers have 
replaced wet darkrooms in 
many people’s homes and offer more 
control and versatility than ever before.

 ➥
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WHAT IS A CONTACT SHEET?

How to get neutral 
black & white prints
‹Printer driver
To adjust the colours 
of your black & white 
prints you’ll need to 
access the colour 
controls in the printer 
driver of most inkjet 
printers. You’ll fi nd this 
in the advanced option 
of most printers, and it 
will allow you to fi ne-
tune the colours you 
get from the printer. 

GREEN CAST

›PUTTING IT INTO PRACTICE
After producing the fi rst print with no 
adjustments we found that it had a green cast. So 
we added +5 on the magenta slider in the printer 
driver (see below) 
before we produced the 
next print. This corrected 
the colour cast and gave 
us a neutral print. Once 
we’d achieved a neutral 
print we went to the 
Save option of the 
printer driver (right) and 
saved these settings for 
future use.

In the traditional darkroom it is 
common practice to print a 
number of negatives at actual 
size by placing them on a sheet 
of photographic paper. It’s 
known as a contact sheet 
because the fi lm is actually in 
contact with the paper when 
you print it. Once it is processed 
this contact sheet allows you to 
quickly view and assess your 
images, saving the hassle of 
having to print each individual 
frame or relying on your ability 
to recognise a great shot from 
looking at the reversed image 
on the fi lm itself. 

You can produce a similar 
print with digital images by 
combining several thumbnail 
images on a single image, then 

printing them on your inkjet 
printer. In Elements 5 go to 
File>Print Multiple Photos to 
fi nd the contact print option. In 
the printing window you can 
choose the Contact Sheet 
option from the drop-down 
menu under the Select Type of 
Print heading, then click the 
Add button to include the 
images you want to print. 

The procedure for creating 
contact prints in Photoshop CS is 
slightly different. Go to 
File>Automate>Contact Sheet II 
and choose the images you 
want to include. In Photoshop 
you’ll fi nd it easier to locate the 
shots you are after if they are in 
a specifi c folder, but in Elements 
you can use the Organizer to 
group your images together. 

After correcting the green 
colour cast we were able 

to produce this neutral 
print of the Yorkshire Dales. 


